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The assessment material and marking scheme in this Coursework pack can be used by staff in 

approved SQA centres for the purposes of assessment of candidates in accordance with the 

Course Assessment Specification.  The pack must not be released to candidates or distributed 

for other purposes.  SQA distributes these materials only to centres;  these materials are not 

distributed more widely and are not publicly available from SQA’s website on the Internet. 

 

 Scottish Qualifications Authority 2011 

 

The information in this publication may be reproduced to support SQA qualifications.  If it is to be 

used for any other purposes written permission must be obtained from the Publications Officer at the 

SQA, Glasgow. 

 

Where the publication includes materials from sources other than SQA (secondary copyright), this 

material should only be reproduced for the purposes of examination or assessment.  If it needs to be 

reproduced for any other purpose it is the centre’s responsibility to obtain the necessary copyright 

clearance.  The SQA’s NQ Delivery:  Exam Operations’ Team at Dalkeith may be able to direct you 

to the secondary sources.   

 

This publication must not be reproduced for commercial or trade purposes.  This material is for use 

by teaching staff only. 
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Organisation and Conditions for Assessment 
 

 
The assessment is designed to test each candidate’s ability to apply knowledge and understanding and 

practical skills, developed through study of the Database Systems and Using Information Units.  The 

mark out of 30 should be submitted to SQA unscaled.  This will be combined with the examination 

mark out of 70 to establish the candidate’s overall grade of award.  This mark should also be used in 

preparation of estimate grades. 

 

The notional design length for the assessment is 8 - 10 hours.  However, a candidate may be allowed 

longer than this if required.  

 

The assessment is to be undertaken under “open book” conditions, but under supervision by the tutor 

to ensure that the work submitted is the candidate’s own work.  The tutor may give the candidate 

hints and/or help if requested.  Any such help should be reflected in the marks awarded.  Once the 

task has been completed and marked, it should not be returned to the candidate for further work. 

 

These instructions are designed to be used in conjunction with the data files provided with the 

electronic distribution of the task.  These can be downloaded from the SQA secure website. 

 

The files to be downloaded should include : 

• The 2011/2012 Intermediate 2 Information Systems Coursework Task  

• SimpleBreaks Task 5-8 database 

• BarcelonaData spreadsheet 

• BookingSS spreadsheet 

 

Candidates are not required to spend time entering data into a database.  Instead, the data should be 

prepared beforehand and provided to candidates by the centre. 

 

To facilitate this, database files for Microsoft Access and FileMaker Pro have been provided for this 

task.  The files contain or represent a number of tables with data entered.  The appropriate file(s) 

should be made available to the candidates. 

 

Centres using alternative relational database software can use the accompanying data files, which 

contain tab-delimited data required for the tables.  The centre should set up tables as appropriate 

within the database software and import the data provided.  The resulting database file should then be 

made available to the candidates. 

 

Candidates should be given a copy of the marking grid before starting the task so that they are aware 

of the mark distribution for each part. 
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Special Arrangements for Intermediate 2 Coursework 2011-2012 

 

Centres are asked to pay special attention to the following arrangements.  
 

• Candidates are not required to spend time entering data into a database. Instead, the data 

should be prepared beforehand and provided to candidates by the centre.  To facilitate this, 

Microsoft Access (2003 format) and Filemaker (v.7) files as well as a text (tab) delimited file 

have been provided.  Centres using other systems will require to create the database from the 

tab separated file provided. This file can also be used if centres encounter any difficulties 

with the supplied Access or Filemaker databases.  

 

• In a change from previous years, candidates are required to set up both tables in the database.  

Candidates will be required to submit a printout of the Documenter (or equivalent screen 

shots) of both the HOLIDAY table and the HOTEL table as evidence for Task 4.  After 

completing tasks 1-4, their work must be submitted and not returned.  Candidates must not 

be given access to the SimpleBreaks Task 5-8 database until they have submitted 

answers to prior tasks. 

 

• Task 4 asks candidates to print out a copy of the design of the tables.  This is to provide 

evidence that the correct field types have been used and all necessary validation checks 

implemented.  The assessor should help candidates produce this printout without penalty.  

 

• Task 3 asks candidates to print out a copy of the relationship between the tables.  The 

assessor should help candidates produce this printout without penalty. 

 

• Candidates will not use their database structures to complete Tasks 5-8.  Instead, centres 

should issue candidates with the fully populated database.  

 

• The SimpleBreaks Task 5-8  is a complete implementation of the system. This working 

database should be issued to candidates after Task 4 has been submitted. Candidates must 

use this working database to complete Tasks 5-8.  

 

• In task 15, candidates are required to research three visitor attractions in one of the listed 

locations.  These should be chosen by the candidate but could be directed by the assessor.  

Research can be done using WWW, travel brochures supplied by the assessor or using other 

reference materials available. 

 

• Images are required, but do not need to be of the actual attraction.  Appropriate images can be 

downloaded, scanned, clipart.  For example, any castle photograph or clipart image might be 

used to illustrate Edinburgh Castle. 

  

• Additional notes follow which detail how candidate evidence is to be generated.  

 

o In FileMaker Pro, to get a printout of the design, candidates should adhere to the 

following instructions. 

(1) Select the “Define” option from the File menu and then select the “Database” 

option from the sub-menu. 

(2) Click on the Tables tab. 



Scottish Qualifications Authority   7 
Coursework Task 

Intermediate 2 Information Systems  2011/2012 

(3) Highlight both tables by clicking on the name of the first table then holding 

down the shift key and clicking on the other table. 

(4) Click on the Print button. 

 

o In MS Access, to get a printout of the design, candidates should adhere to the 

following instructions.   

(1) Select the “Analyze” option from the Tools menu and then select the 

“Documenter” option from the sub-menu. 

(2) Select the table(s) required and then click Options button. 

(3) Make sure that the following options are checked/selected: 

• Include for Table 

 Properties 

 Relationships 

• Include for Fields 

 Names, Data Types, Sizes 

and Properties 

• Include for Indexes 

 Names and Fields 

 

(4) Click on OK 

(5) The required table design is 

displayed on screen and can be 

printed. 

 

 

o Printing Relationships in FileMaker 8. 

(1) Select the “Define” option from the File menu and then select the “Database” 

option from the sub-menu. 

(2) Click on the Relationships tab then click on the Print button. 

 

o Printing Relationships in Access 

(1) Open the Relationships window. 

(2) Select the “Print Relationships” option from the File menu. 

 

Alternatively, screendumps of the evidence would also be acceptable. 
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Intermediate 2 Information Systems  

Coursework Task 2011/2012 
 

 

SimpleBreaks offers a number of holidays in a variety of European cities.  Each holiday has a set 

departure date and length of stay in a specified hotel. 

 

SimpleBreaks wants to store details about the holidays and the hotels in a relational database so it is 

easy for travel agents to answer questions from travelers such as “Which holidays do you have in 

Edinburgh?” or “Do you have any 4 night breaks in Barcelona?” 

 

SimpleBreaks have designed the tables required for the database. 

 

Hotel table 

Field Name Field Type Field Size Key Format Sample Data 

Hotel Ref Text 4 Primary Key  H101 

Hotel Text 30 No  Catalonia Inn 

City Text 20 No  Barcelona 

Grade Text 6 No  2 star 

Price per Night Number  No Currency 

0 decimal places 

£40 

Kilometres from 

airport  

Number  No 1 decimal place 1.1 

 

Holiday table 

Field Name Field Type Field Size Key Format Sample Data 

Title Text 30 Primary Key  Catalonia Caper 

Destination Text 20 No  Catalonia 

Country Text 20 No  Spain 

Date of Departure Date  No dd/mm/yyyy 25/06/2013 

Nights Number  No  3 

Hotel Ref Text 4 Foreign Key  H101 
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What you have to do  

 

 Tasks Evidence Required 

1  Using a relational database application create a new database file 

and set up the Holiday table and the Hotel table.  You should 

use the design shown on the previous page. 

 

 

2  Each hotel is given a star rating which can be 1 star, 2 star, 3 star, 

4 star or 5 star. 

Set up the Grade field in the Hotel table with a restricted choice 

validation check.  This should be set to allow only these five 

options to be entered. 

 

 

 

3  Link the Hotel table to the Holiday table using the foreign key.  

Print out a copy of the relationship showing the link between the 

tables. 

 

Printout/screendump of 

the relationship window 

showing the link between 

the two tables. 

4  Print out a copy of your design for both tables in the database.  

This should show the field types, field sizes and validation 

checks. 

 

 

(If you are unsure how to do this, your assessor will be able to 

help you.) 

Printout/screendump of 

the Hotel table and 

Holiday table design 

showing field types, field 

sizes and validation 

checks. 

 

 

You must now submit Tasks 1-4 to your teacher/lecturer 
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Your teacher/lecturer will provide you with the database file SimpleBreaks Task 5 -8.  You must 

use this version to complete tasks 5, 6, 7 and 8 

 

What you have to do (continued) 
 

 Tasks Evidence Required 

5 Design and create an attractive and user friendly form/layout to 

display all the details for one holiday including the details of the 

hotel. 

 

Your layout should be formatted so that the name of the holiday 

and the name of the hotel clearly stand out. 

 

Produce a one page printout using this form/layout ensuring that 

all fieldnames and data can be clearly seen.  

Printout of the 

form/layout showing all 

details. 

6  Produce a printout of a report/layout showing all the holidays in 

Spain at 5 star hotels. 

  

The printout should display only the following fields:  

Title, Destination and Hotel 

 

Save your work as Task 6.  

 

Your name must be included in the report as a header or 

footer. 

Printout of all 5 star 

Spanish holidays in a 

report/layout as 

specified. 

7  Produce a printout of a report/layout showing all the hotels in the 

city of Paris for holidays starting in August. 

 

The printout should display only the following fields:  

Title, Destination, Hotel, Date of Departure, Nights and 

Kilometres from airport. 

 

Save your work as Task 7.  

 

Your name must be included in the report as a header or 

footer.  

Printout of all holidays in 

Paris hotels starting in 

August in a report/layout 

as specified. 

8  The manager of SimpleBreaks wants a list of all the holidays for 

at least 4 nights in hotels costing less than £65 per night. 

 

Produce a printout of a report/layout showing the appropriate list 

of holidays. The report data should be listed in order of length of 

holiday, shortest first.  If there are two or more holidays of the 

same length they should be listed in order of price, lowest first. 

 

The printout should display only the following fields:  

Title, Nights and Price per night 

 

Save your work as Task 8  

 

Your name must be included in the report as a header or 

footer.  

Sorted printout of all 

holidays with at least 4 

nights and costing less 

than £65 per night in a 

report/layout as 

specified. 

Collect all printouts in the order they were asked for.  Ensure your name and task number is 

printed on each report before handing to your teacher/lecturer. 
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SimpleBreaks is often asked about the climate in the holiday destinations.  The company wants to create 

a graph for each destination showing the monthly temperature and rainfall throughout the year. 

 

What you have to do (continued): 
 

 Tasks Evidence Required 

9 Note: Your teacher/lecturer will provide you with the file 

BarcelonaData containing the spreadsheet data.  

 

Open the file called BarcelonaData. 

 

You have to create a single graph that shows the temperature as 

a bar graph and rainfall as a line graph for each month in 

Barcelona. 

 

Your graph should include clearly labelled axes, a suitable title 

and a key which indicates which part of the graph shows 

temperature and which part shows the rainfall. 

 

 

10 Print the BarcelonaData chart. 

 

Your name and task number must be included in the chart as 
a header or footer.  

Printout of one graph, 

correctly labelled, 

showing temperature (bar 

chart) and rainfall (line 

graph). 
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SimpleBreaks keeps track of bookings for holidays in a spreadsheet.  The manager asks you to update 

the spreadsheet to calculate the total cost of the booking and how much has to be paid as a deposit. 

 

What you have to do (continued) 
 

 Tasks Evidence Required 

11 Note: Your teacher/lecturer will provide you with the file 

BookingSS containing the spreadsheet data. 

  

Open the file called BookingSS.  

 

Enter a suitable formula in column H to automatically calculate 

the total cost of each booking. This is calculated by multiplying 

the number of people travelling by the price per night by the 

length of stay.  

 

 

12 If the Total cost of booking is £500 or more, then a 20% deposit 

must be paid, otherwise a 40% deposit must be paid.  

 

Enter a suitable formula in column I to automatically calculate 

the amount of deposit to be paid.  

 

 

 

The manager wants a list of bookings for the Hotel Ref H133. 

 

What you have to do (continued) 
 

 Tasks Evidence Required 

13 Filter the spreadsheet data to show only the bookings for Hotel 

H133. 

 

 

14 Print two copies of your spreadsheet ─ one showing the answers 
and another showing the formula used.  

 

Your printouts must include the column and row headings. 
 

Your name and task number must be included in the 
printouts as a header or footer.  

 

Two printouts of 

spreadsheet – one 

showing booking details 

for hotel H133 and one 

showing formulas used. 
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Holidaymakers often ask questions about things to do or places to see in their holiday destination.  

SimpleBreaks asks you to research some tourist attractions in one destination and create a single page 

printed leaflet which tourists can take with them on their holiday. 

 

What you have to do (continued): 
 

15 Select one destination from those offered by SimpleBreaks – 

Barcelona, Berlin, Madrid, Paris, London, Lisbon, Rome, 

Edinburgh or Dublin. 

 

Using suitable resources, research three things to do or places to 

visit in that destination.  As well as finding a few lines of facts 

for each visitor attraction, you should also find a picture to 

illustrate each visitor attraction. 

 

 

16 Create a single page leaflet by 

• entering the city destination as the title and the sub 

headings for each visitor attraction 

• formatting the titles and subtitles using a suitable font, 

size and style 

• entering the facts for each visitor attraction  

• inserting a picture illustrating each visitor attraction 

• formatting the body text using a suitable font, size and 

style 

• adding a border around the facts and picture for each 

visitor attraction. 

 

 

17 Print the completed leaflet 

 

Your name and task number must be included in the 
printout as a header or footer.  

 

One single page printout 

as specified showing 3 

visitor attractions. 

 

(30 marks) 

 
Collect all printouts in the order they were asked for.  Ensure your name and task number is on 

each printout before handing to your teacher/lecturer. 
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Marking Grid 
 

Name    Date    

 

Topic 
Possible 

Marks 

Marks 

Gained 
Comment 

Task 1─4 
Create the 

database 

Creation of tables 3,2,1,0   

Restricted Choice 1,0   

Link tables 1,0   

 

Task 5 Form/Layout Printed Layout 2,1,0   

 

Task 6 Report 
Correct Search 1,0   

Correct Report Printed 1,0   

 

Task 7 Report 
Correct Search 1,0   

Correct Report Printed 1,0   

 

Task 8 Report 

Correct Search 1,0   

Correct Sort 2,1,0   

Correct Report Printed 1,0   

 

Tasks 9─10 Chart Correct Chart Printed 3,2,1,0   

 

Tasks 11─14 Spreadsheet 

Calculate Total Cost 1,0   

Calculate Deposit 3,2,1,0   

Filter Results 1,0   

Print 1,0   

 

Tasks 15─17 Leaflet 

Research Facts 1,0   

Include Pictures 1,0   

Formatted Leaflet 3,2,1,0   

 

All Printouts Name and Task 1,0   

 
 Overall Total  30   
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CONFIDENTIAL – not to be issued to candidates 

Detailed Marking Guidelines 
 

The following guidelines assume that all work was carried out by the candidate on their own (or with 

the assistance of open book materials).  Any assistance by the assessor should be reflected in a 

reduction of the number of marks awarded. 

 

Tasks 1-4 
Create the 

database 

Creation of tables 3,2,1,0 Accurate creation of 

• all tables and field names and PKs (1 

mark) 

• all field types and sizes (1 mark) 

• all formatting (1 mark) 

 

Restricted Choice 1,0 Grade set to restricted choice – only 1 star, 2 

star, 3 star, 4 star, 5 star values accepted 

Link tables 1,0 Tables linked without teacher help using Hotel 

Ref 

 

Task 5 
Form/ 

Layout 

Printed Layout 2,1,0 • One page layout created without help.  All 

fields from both tables should be clearly 

visible.  (Hotel Ref should only appear 

once) (1 mark) 

• Appropriate design with Holiday name and 

Hotel name standing out using larger size 

or different style or colour etc (1 mark) 
 

Task 6 Report 

Correct Search 1,0 Complex search for  

• Country is Spain 

• Grade is 5 star 

Correct Report 

Printed 

1,0 Title, Destination and Hotel fields included and 

clearly visible. 
 

Task 7 Report 

Correct Search  1,0 Complex search for  

• City is Paris 

• Month is August 

Correct Report 

Printed 

1,0 Title, Destination, Hotel, Date of Departure, 

Nights and Kilometres from Airport fields 

included and clearly visible. 
 

Task 8 Report 

Correct Search 1,0 Complex search for  

• Nights greater than or equal to 4 

• Price per night less than 65 

Correct Sort 2,1,0 Complex sort (2 marks) 

• Nights ascending 

• And Price per night ascending 

Simple sort (1 mark) 

Otherwise (0 mark) 

Correct Report 

Printed 

1,0 Title, Nights and Price per night fields included 

and clearly visible. 
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Tasks 9-10 Chart 

Correct Chart Printed 3,2,1,0 Correct Graph 

• Single graph showing temperature as bar 

graph and rainfall as line graph (2 marks) 

• Legend, Title and labelled X and Y axes 

(1 mark) only need 1 Y axis labelled 

• 2 separate but correct graphs with labels 

etc 1 mark only 

 
 

Tasks 11-14 
Spreadsheet 

 

Calculate Total Cost 1,0 =E2*F2*G2 

Replicated down column correctly 

=SUM(E2*F2*G2) – 0 marks 

Calculate Deposit 3,2,1,0 =IF(H2>=500,20%*H2,40%*H2) 

Replicated down column correctly.  

 

Correct condition (1 mark)  

Correct TRUE calculation (1 mark)  

Correct FALSE calculation (1 mark)  

 
Other correct formulas acceptable  

such as  

=( H2<500,40%*H2,20%*H2)  

=( H2>=500,0.20* H2,0.40*H2) 

Filter Results 1,0 Only bookings for H133 visible in rows 17, 18, 

58, 59 

Other rows not visible but not deleted. 

Print 1,0 One printed version showing answers to formula 

calculations and filter results with row/column 

headings visible and one printed version 

showing formulas used. 

 

Tasks 15-17 
Leaflet 

 

Research Facts 1,0 • Enter relevant facts on 3 attractions for 

one destination 

Include Pictures 1,0 • Insert suitable picture of visitor attraction 

Formatted Leaflet 3,2,1,0 Formatted as specified 

• Title and 3 subheadings in suitable and 

consistent font, size, style (1 mark) 

• Body text with appropriate and 

consistent font, size, style (1 mark) 

• Borders included (1 mark) 

 
Tasks  

6, 7, 8 

and 

10, 14, 17 

Printouts 

 

Name and Task 1,0 All printouts include printed name and task 

number in header or footer 

 Total Marks 30  
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Sample Solutions 
 

Task 3 - Relationship 

 or  

 

Task 5 

Example A - 2 marks 
Good consideration of design, all fields visible. 

Holiday name and hotel name clearly stand out using appropriate feature.   

 
 

Example B - 1 mark. 
No consideration of design or highlighting as specified, but all fields included and visible.  
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Task 6 – 7 records 

 

 
 

 

Task 7 – 6 records 
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Task 8 –  20 records 
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Task 9 – Single graph showing temperature and rainfall, correctly labelled 

 

Example 1 – 2 marks 

Single graph, title included and labelled axes (temperature left & rainfall right) 

 

 
 

Example 2 – 2 marks 

Single graph, title included and labelled axes (both averages left axes) 
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Task 14:  Answers 
 

Spreadsheet showing result of calculations 

 
 

Spreadsheet showing formula used for calculations 

 
 

Task 17 – Leaflet 

 

Any suitable layout – some examples shown below 
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